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About i-access Kiosk
This i-access Kiosk (Kiosk) software allows you to download titles from your Vision Australia Library online bookshelf to an Envoy Connect player or your Computer.
To use Kiosk you have to be a registered member of the Vision Australia Library and have a Username and Password.
If you are not a member, contact the Vision Australia Library on 1300 654 656, or email: library@visionaustralia.org
i-access Kiosk is designed for Microsoft Windows 10.
For Kiosk to work, the computer must be connected to the internet.
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There are two methods of installing the Kiosk software:
· Directly from the Envoy Connect player
· Downloading from Vision Australia
[bookmark: _Toc55231814]Installing from the Player
The i-access Kiosk software can be found in the SYSTEM folder on the Envoy Connect player.  The installation file is called KioskSetup.exe.
To install the software, ensure the player is switched off, then plug it into the computer using a USB data cable.  A USB cable is supplied with the player.  The player will emit a chime to confirm the connection.
In Windows Explorer, the connected player is called CONNECT.  Open this to view the SYSTEM folder on the player.
Within the SYSTEM folder, there is a folder called ‘i-access Kiosk’.  The Kiosk software is in this folder.
Select the ‘KioskSetup.exe’ or ‘i-access Kiosk.exe’ file to begin installation.
During installation, you may be presented with a Microsoft Windows Warning asking if you want to install the software.  Select the ‘Install’ button. 
An ‘i-access Kiosk’ shortcut (icon) will be placed on your desktop when the installation is finished.  
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The i-access Kiosk software can be downloaded from: http://softwareupdate.i-accessonline.visionaustralia.org/iaccesskiosk/KioskSetup.exe 
Once the Kiosk software has finished downloading to the Downloads folder on the computer, select the ‘KioskSetup.exe’ file to begin installation.
During installation, you may be presented with a ‘Microsoft Windows Security Warning’ asking if you want to install the software.  Select the ‘Install’ button. 
An ‘i-access Kiosk’ shortcut (icon) will be placed on your desktop when the installation is finished.
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You can select two modes of operation for the Kiosk software:
· Envoy Connect mode (Download to an Envoy Connect player)
· Local Computer mode (Download to the Computer)
The Envoy Connect mode is the default mode.
These two modes are described further in the ‘Kiosk Mode’ section below.
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Ensure your Envoy Connect player is switched off, then connect your player to the computer using a USB data cable (supplied with your player).  The player will emit a chime to confirm the connection.
Note that if you run Kiosk before plugging in the player, you will be prompted to plug it in.
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To run i-access Kiosk, use the i-access Kiosk icon on your computer desktop.
When you first run Kiosk a ‘Quick Start Guide’ will appear that provides a brief overview of the Kiosk software as well as tell you ‘what’s new’ in the Kiosk software.
You can choose not to display the Quick Start Guide next time you run Kiosk by unticking the ‘Show next time on Startup’ checkbox.  You can also access the Quick Start and this User Guide at any time from the Help menu.
Select the ‘Close’ button to proceed.
A message will confirm that a player is plugged in.
Select the ‘Continue’ button to proceed or the ‘Cancel’ button to return to the main screen.
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Enter your Library Username and Password.
Tick the ‘Save Username and Password’ checkbox if you want to avoid entering it each time you run Kiosk.  Note that if your login fails for any reason, the login page is presented again.
Select the ‘OK’ button to proceed.
Kiosk will connect to the Vision Australia online Library.
Note that logging in may take a few minutes depending on the size of your online bookshelf and the speed of your internet connection.  Do not unplug your player while it is connecting.
You can check the login progress in the Status field within the next window.
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When connecting to the Library and downloading, a status field shows the connection progress.  This window also shows the Username of the logged in person and the player serial number.
Select the ‘Cancel’ button if you want to stop the process at any time and return you to the main screen.
Note that if you cancel downloading, only those titles that had completed downloading will be playable on the player.  When you next run Kiosk, you will need to reselect the titles from your bookshelf to resume downloading them.
Note that the title bar displays the current Kiosk mode (Envoy Connect or Local Computer).
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Once Kiosk has logged on and connected, Kiosk will display the ‘Select Titles to Remove’ window.
This is the list of titles currently on your Envoy Connect player.
Select one or more titles from the list to remove them from your player.  Doing so will also remove them from your online bookshelf.
Removing titles form your player will also allow more titles to be added to your online bookshelf to replace those that you remove.
You can also choose to use the ‘Select All’ or ‘Deselect All’ buttons.
Note that you do not need to remove any titles, however, eventually the memory on the player will become full preventing you from downloading more titles.
Select the ‘Next’ button to proceed.
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Kiosk will display the ‘Select Titles to Download’ window.
This is the list of titles currently on your Online Library bookshelf that you can download.
Select one or more titles from the list to download to your player from your online bookshelf.
You can also choose to use the ‘Select All’ or ‘Deselect All’ buttons.
Select the ‘Next’ button to proceed, or the ‘Cancel’ button to return to the previous screen.
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Kiosk will ask you to confirm the selections you have made in the previous windows.
Select the ‘Next’ button to proceed with the content update.
If you wish to review or change your selections, select the ‘Back’ button. 
Note that if you use the ‘Back’ button you will need to reselect any titles you had previously selected.
You can select the ‘Cancel’ button if you want to ignore all previous steps and return to the main screen.
Note that downloading content onto your player may take some time depending on how many titles you have selected and the speed of your internet connection.
Once the downloading of content commences, the Status field will keep you informed of progress.
Do not disconnect the player or exit the program until Kiosk confirms 'Player Update Completed'.
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A ‘Content Updated’ confirmation message will be displayed once the download of content has finished.
It is now safe to disconnect the player.
Select the ‘OK’ button to return to the main screen of Kiosk or select the ‘Exit’ button to close the software.
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The instructions for ‘Local Computer’ mode are the same as Envoy Connect mode, except that content is downloaded to your local computer.
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When you select Local Computer mode, a new folder called ‘i-access Kiosk Content’ is placed on your computer desktop.  This is where all downloaded titles are saved in Local Computer mode.
Note that this folder may contain a file called ‘_Bookshelf.xml’.  If this file is visible in Windows Explorer, do not move or delete it.  Doing so may affect the content update process.  If you accidentally move or delete this file, please contact the Vision Australia Library for assistance.
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This window allows you to manually start the content update process.  It also provides access to the File menu and Help menu.
You can select the 'Connect to Library' button to connect to the Vision Australia Library, review your online bookshelf and update content on your player or computer.
Select the ‘Exit’ button if you are finished using the Kiosk software.
Note that the title bar displays the current Kiosk mode (Envoy Connect or Local Computer).
[bookmark: _Toc55231829]File Menu
[bookmark: _Toc55231830]Options
[bookmark: _Toc55231831]Kiosk Mode
You can select two modes of operation for the Kiosk software:
· Envoy Connect mode
· Local Computer mode
These two modes are described below.
After you set your preferred mode, select the ‘OK’ button to save your changes and return to the main screen.
Select the ‘Cancel’ button to return to the main screen without saving your changes.
Note that Kiosk will remember the currently selected mode each time you run the software.
Envoy Connect Mode
Select this mode to manage content on your Envoy Connect player.
This mode allows you to choose new titles to download from your Library bookshelf onto the Envoy Connect player, and titles you would like to remove from the player.
Local Computer Mode
Select this mode to manage content on your local computer.
This mode allows you to choose new titles to download from your Library bookshelf onto the computer, and titles you would like to remove from the computer.
Show Release Notes on Startup
If you previously chose not to show the Quick Start Guide on start-up, you can select ‘Show Release Notes on Startup’ so that the Quick Start Guide is displayed again when you next run Kiosk.
Clear Saved Username and Password
If you previously chose to save your username and password when logging in, you can select the ‘Clear Saved Username and Password’ button so that you are prompted to enter them again when you next run Kiosk.
Note that this button will only appear if you have previously saved your Username and Password.
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The ‘Use default location in Local Computer mode’ checkbox is ticked by default.  This saves downloaded titles to the ‘i-access Kiosk Content’ folder on your computer desktop.
You can choose a different location by unticking the checkbox and selecting ‘Browse’.  This opens a ‘Browse For Folder’ window where you can choose a different location or create a new folder by using the ‘Make New Folder’ button.  Select the ‘OK’ button to save your preferred location.  Use the 'Cancel’ button to return to the Options menu without saving your changes.
The ‘Content Location’ field displays the file path.
Note: when choosing a different folder location, be sure not to choose the CONNECT Drive.  This drive is the Envoy Connect player.  If you wish to download to the player, choose Envoy Connect Mode from the Options menu.
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After you set your preferences, select the ‘OK’ button to save your changes and return to the main screen.
Select the ‘Cancel’ button to return to the main screen without saving your changes.
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This opens the Vision Australia ‘MyVA’ website.  Here you can access your Library account to set preferences and add titles to your bookshelf for the Kiosk software to use.  You can also access other Vision Australia services.
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Select Exit to close i-access Kiosk.
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Opens the Quick Start Guide.
Select the ‘Close’ button to return to the main screen.
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Opens this User Guide.
Select the ‘Close’ button to return to the main screen.
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Information about i-access Kiosk, including the version number.
Select the ‘OK’ button to return to the main screen.
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Each time you run i-access Kiosk, it checks if a later version is available.  If a software update is available, it will automatically update.
When a software update occurs, a progress status screen will appear momentarily.  You do not need to do anything.  When the software update is finished, Kiosk will open as normal.
If a software update has occurred, the ‘Quick Start Guide’ will be displayed and describe ‘What’s New’ in the latest version of i-access Kiosk.
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We want your experience using i-access Kiosk to be the best possible.  If you have any questions or comments, please contact the Vision Australia Library on 1300 654 656 or email: library@visionaustralia.org 
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